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Introduction

Introduction
The RISA CIS/2 translator is a tool for transferring data between the RISA-3D program and the CIM steel part 21
file format.    There are two basic modes for the CIS/2 translator: Export mode and Import mode.

When the user picks “EXPORT” option in the “Translator” group box, the main dialog box will be displayed as
export mode. When the user picks the “IMPORT” option in the “Translator” group box, the main dialog box will be
displayed as import mode.

Export mode
Files will be translated from RISA input file format to CIS/2 part 21 file. Export is available for both RISA-3D
input files and RISAFloor input files.

Import mode
Files will be translated from CIS/2 part 21 files to RISA-3D input format. (Note: RISAFloor format is not currently
available for import).
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Products Group Box (available both Export and Import mode)
The product group box defines the format of the input file. Eventually the user will be able to choose between a
RISA-3D format or a RISAFloor format as the input file. However, RISAFloor import is not supported for the cur-
rent version of the CIS/2 link. Therefore, only the RISA-3D radio button will appear in the “products” group box
in import mode.

Input File (available both Export and Import mode)

An input file can be selected by clicking the button. You can also type the directory and file name in the
input file edit box. An input file is required for translation.

Output File (available both Export and Import mode)

To overwrite/update an existing output file, select the file using the button or by typing the directory and
file name in the input file edit box. To generate a new output file, you can type the directory and file name in the
edit box, type in the file name only, or leave the edit box empty. If the edit box is blank, the translator will auto-
matically generate a file name and place it in the same directory as the input file. If the edit box has a file name
but no directory in it, the translator will place the output file in the same directory as the input file.

Model Choice Group box (available in both Export and Import mode)
There are three types of models in CIS/2: the analysis model, the design model and the manufacture model. RISA
is capable of handling the analysis model and the design model. The manufacture model is not in the scope of
RISA software and will not be processed by our translator. A typical analysis model contains elements, nodes,
loading conditions, boundary conditions and end releases. A typical design model, on the other hand, contains the
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information of member shapes, design parts, etc. (Please refer to the entity list section for details). By clicking
on the checkbox “design model” and/or “analysis model”, you choose whether to export a design model, an ana-
lysis model, or both. For a complete export for a RISA model, it is recommended to have both the “design model”
and “analysis model” selected.  Both the CIS/2 design model and the analysis model contain loads. In most cases,
exporting loads in either design or analysis model should be enough. If you choose to export loads in both design
and analysis model when doing the round-trip import from CIS/2 model back to the RISA model, the load will
appear doubled. Therefore, it is recommended to write the loads in the analysis model only.

By default, both analysis and design model will be exported, and load will only be exported to the analysis model.

Detailing Choice Group box (available in Export mode only)
The Detailing Choice group box controls the export of member detailing information. There are three options
here: None, Use Cardinal Points and Use Element Eccentricity

None

When “none” is selected, no detailing information will be translated in the exported CIS/2 model.

Use Cardinal Points

If the “Use Cardinal Point” option is picked and if the defined connection location falls on a cardinal point, the con-
nection point will be translated as the “cardinal_point” value in the “section_profile” entity for that particular
member. For the time being, only cardinal point 1 thru 10 is supported in the current version. The “Use Cardinal
Point” option is the more popular way for describing the detailing information.

Note:

l The connection point needs to fall exactly on a cardinal point location.
l A cardinal point is stored as a section property for each member. Thus, if you have a brace that is con-
nected at a different cardinal point at either end, one offset will be lost. It is recommended to "Use Ele-
ment Eccentricity" in these cases.

Use Element Eccentricity

If the “Use Element Eccentricity” option is chosen the connection point information is translated to the “element_
eccentricity” entity in the CIS/2 model and can later on be further processed by a detailing program like SDS/2.
There are two options for “Use Element Eccentricity” selection, “End Pullback” and “No End Pullback”. When the
“End Pullback” option is selected, the complete detailing offset will be exported. When the “No End Pullback”
option is selected, the detailing offset local y and local z direction (perpendicular to the members) will be expor-
ted, the local x offset in the member direction will be 0. (SDS/2 will prefer this option for better handling of
data)

The exported detailing information has been tested with SDS/2. By default, “No End Pullback” is selected.

Vertical Axis Group box (available in Import mode only)
In export mode the RISA CIS/2 translator will always export a model with Z as the vertical axis. In import mode,
the RISA CIS/2 translator will always assume that the .stp file has the global Z as the vertical axis.

RISA-3D and RISAFloor accept the X, Y, or Z axis as the vertical axis, thus when the user is importing a model
from the CIS/2 model to RISA format, it is required for the user to define the vertical axis.

When the “X”, “Y”, and “Z” option is selected, the translator will define both the vertical axis of the import model
as well as the member orientation option. When “X” is picked, the vertical axis will be in the global X direction
and the default member orientation will Force member local z axis to be on the YZ plane. When “Y” is picked, the
vertical axis will be in the global Y direction and the default member orientation will force member local z axis
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to be on the XZ plane. When “Z” is picked, the vertical axis will be in the global Z direction and the default mem-
ber orientation will Force member local z axis to be on the XY plane.

(For detailed information about vertical axis and member orientation, please refer to “RISA-3D reference
manual”)

Set Mapping Files Button (available in both Export and Import mode)
When the Set Mapping File button is clicked, the following dialog box will show up. 

You can pick a section/material mapping file by clicking the button or by typing in the directory and file-
name of the mapping file. If a mapping file is not desired, just leave the edit box empty. For details about sec-
tional mapping and material mapping, please refer to the “Mapping files” section.

Save As Defaults Button (both Export and Import mode)
The RISA CIS/2 translator automatically remembers the previously used “translator mode (import/export)”, “file
format (RISA3D/RISAFloor)” and file names. However, for the more advanced settings, such as “Model choices”,
“Vertical axis”, and “Detail Choice”, the program will go back to the default setting every time the program is
restarted. In order to save the current setting to be the default, the “Save As Defaults” button needs to be
clicked. The “Save As Defaults” button only saves the options for the current translator mode. For example, when
user is running in the export mode, only the options associated with export will be saved. The default settings
are saved in three files in the program directory:  cis2.def, cis2import.def and cis2export.def. The “cis2.def” file
includes previous translator mode, file format and file names. The “cis2.def” file is saved automatically every
time you hit the “RUN...” button. The “cis2import.def” file includes all the default advanced options for import
mode. It is saved when you press the “Save As Defaults” button under import mode. The “cis2export.def”file
includes all the default advanced options for export mode. It is saved when you press the “Save As Defaults” but-
ton under export model.   

View Error Log Button (both Export and Import mode)
By clicking this button, the error log of the previous translation will show up. An Error_log.txt file will be writ-
ten out with each import or export to the output location. This is an overall log of what got translated and what
did not.

Run Button (both Import and Export model)
The program will start the translation if this button is clicked.

Exit Button (both Import and Export model)
The program will exit if this button is clicked.

Help Button (both Import and Export model)
The help menu will be launched if this button is clicked.
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Cardinal Points

Overview
A detailing layer has been built for both 3D and Floor that lets the user set the "true" elevations and locations
start/end, top of steel, etc...) for all members. For each member (both column and beam in the case of Floor), a
new data structure has been added to describe the connection point at member ends.

The areas in RISAFloor and RISA-3D where member detailing parameters can be added/viewed are:

l RISAFloor
l Beams Data Entry Spreadsheet>Detailing tab
l Columns Data Entry Spreadsheet>Detailing tab
l Plot Options>Beams/Columns/Walls tab

l RISA-3D
l Members Data Entry Spreadsheet>Detailing tab
l Double-clicking Individual Member>Detailing tab
l Graphic Member Drawing>Member Detailing tab
l Plot Options>Members tab

For each end of the member, both cardinal point positions and decimal local offsets are used to described the con-
nection location. The location of the cardinal point is plotted as follows:

Figure 1 Cardinal point Location and Local Axis

Cardinal point 1:lower left corner of the member section bounding box
Cardinal point 2:lower center point in the member section bounding box
Cardinal point 3:lower right corner of the member section bounding box
Cardinal point 4:mid-depth left point in the member section bounding box
Cardinal point 5:mid-depth center point in the member section bounding box
Cardinal point 6:mid-depth right point in the member section bounding box
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Cardinal point 7:upper left corner of the member section bounding box
Cardinal point 8:upper center point in the member section bounding box
Cardinal point 9:upper right corner of the member section bounding box
Cardinal point 10:Geometric centroid of the member section

Note:

l Only cardinal point 1-10 are supported by RISA. You may instead use an offset.

The x, y, and z offsets are based on the local axis of the member. The x local axis is defined along the member
from I to J. It coincides with the  geometric centroid of the member section. The standard cardinal point pos-
itions (1-10), as well as the decimal local offsets are both supported in current detailing definition. If the cardinal
point is set, the y and z offset values will be automatically calculated and filled in the data structure. If there is a
situation that doesn't match a cardinal point (angle brace as an example) you can also set the y and z offsets dir-
ectly.

Note:

l The TOM and Rigid End Offset are completely different concepts from the detailing offset. The purpose of
the detailing offsets is more realistic visualization and plotting of the model. The detailing offsets are not
considered during the analysis. In the analysis, all members are still connected at their geometric
centroid. TOM and Rigid End Offsets, on the other hand, affect the load distribution and design of the mem-
ber. They are analysis parameters. In our program, the TOM / Rigid End Offset are completely separate
data structure from the detailing offsets. When TOM is set for a model, for example, the detailing inform-
ation will NOT be automatically updated to cardinal point 8 accordingly.

Detailing Input and Modification:
There are three ways for setting and modifying the detailing layer information. User can use the graphical mem-
ber modify, the double-click dialog and the member detailing spreadsheet to set the detailing information.

Default
When a member is drawn, by default, x offsets are set to be 0 on both ends. If the member type is beam , by
default the y and z detailing offsets will be on cardinal point 8 ( top center) for both ends. If the member type is
column, by default the detailing offset will be on cardinal point 10 for both ends.

Graphical member modify
A Member Detailing tab has been added to the Graphical member draw/modify window. The user can choose
to “set y, z offset using cardinal point” or “set y, z offsets directly”. When a cardinal point is picked, the value in
the “y Offset” and “z Offset” text box will automatically be updated.
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Figure 2.A Member Detailing Tab in Graphical Member Modify (RISA-3D)

Figure 2.B Column/Beam Detailing Tab in Graphical Member Modify (RISAFloor)

Double click dialog
A Detailing tab has been added to the double click dialog for the displaying and modification of the detailing info. 
The user can choose to “set y, z offset using cardinal point” or “set y, z offsets directly”. When a cardinal point is
picked, the value in the “y Offset” and “z Offset” text box will automatically be updated.
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Figure 3 Detailing Tab in double click dialog

Spreadsheets
A detailing tab has been added for the member spread sheet (Column and Beam grid in the case of FLOOR). The
spreadsheet shows a label and 8 values for each member. The “I cardinal point” and “J Cardinal Point” are pull
down list with numbers and a description. When user picks a cardinal point, the y and z offset values will update
automatically based on the current shape.  When a new y and z offset are input by the user and it doesn’t fall on
any cardinal point, the “Cardinal Point” will automatically change to “None”. When the “Member Detailing” grid
is active, a toolbar button is added to recalculate values based on new shapes (Figure 5).

Note:

l When the design shape of the member is changed, the detailing offsets of the member is not automatically
updated. The recalculate tool bar button needs to click to get new y, z offset with respect to the cardinal
point picked)

Figure 4.A Detailing Tab in Member Spreadsheet(RISA-3D)
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Figure 4.B Beam/Column Detailing Tab in Member Spreadsheet(RISAFloor)

Figure 5 Recalculate Detailing Offset button when Member Detailing Spreadsheet in Active

Visualization of the Detailing Layer
To visualize the model with the detailing layer, go to the plot option dialog box and member tab. Check the
“Detailing Info” check box (Figure 6). 
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Figure 6.A Detailing Info checkbox in plot option window (RISA-3D)

Figure 6.B Detailing Info checkbox in plot option window (RISAFloor)

Note:

l When the Detailing info box is checked. The members will be plotted solely using the x, y and z offsets.
The “TOM” and “Rigid End Offset” will not be considered in the plotted here.

File I/O
[.MEMBERS_DETAILING_DATA]data section is added to the .R3D file to hold the member true location data. [..RF_
COLUMNS_DETAILING_DATA] and [..RF_BEAMS_DETAILING_DATA] data section are added to the .RFL file to hold
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member true location data. The CIS2 translator is updated to read/write this new data section.
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What is Supported with this Translator?

Elements
Only member elements are supported with the CIS/2 translator. Plate and solid elements are not supported in
the current version.

Loading conditions
The current CIS/2 translator only supports joint loads, member concentrated loads and member distributed
loads. Member area loads and plate surface loads are not supported. In the current version, only static loads will
be considered in the translation. Dynamic loading in the model will be ignored. RISA joint loads can be defined in
the form of mass, displacement and forces. During the translation, only the force type of load will be translated.
The mass and displacement loads will be ignored.

Sections Sets
CIS/2 does not understand the concept of section set. Therefore, in order to export the model correctly, mem-
bers need to be explicitly defined with a shape name.

Physical Members and Member mapping
In CIS/2, design members and analysis members are related by the entity “member_mapping”. The “member_
mapping” entity maps one design assembly to one or multiple analysis elements. This concept is consistent with
the concept of physical member in RISA-3D. The physical members are broken down to several FEM elements
during the analysis, and considered to be one single piece during the design.

When exporting, if the design model is selected, the RISA CIS/2 translator will generate one “assembly_design_
structural_member_linear” entity for each physical member in the design model. If the analysis model is selec-
ted, the RISA CIS/2 translator will generate multiple analysis entity according to the joints (or physical pieces)
on the RISA physical member.  If both the analysis model and design model is selected, the “assembly_map”
entity will be generated to store the logical relationship between the design entities and analysis entities

When importing, if the user chooses to import both the design model and analysis model, the program will
search for the “assembly_map” and map the design entity and analysis entity to be one physical member. If
“assembly_map” entity isn't present in the CIS/2 model, then design assembly and analysis entity will be trans-
lated as separated members into the RISA file. There will be no physical member generated. If only Analysis
model or Design model is selected in the translator, the program will not import the “assembly_map” entity.
Even though it might be present in the model, no physical members will be generated.

Model Choice assembly_design_structural_mem-
ber_linear element_curve_simple assembly_map

Analysis model No Yes No
Design model Yes No No
Analysis & Design
model Yes Yes Yes

12 CIS/2 Translator v1.0

What is Supported with this Translator?



Mapping Files

Mapping Files
Different programs have their own naming convention for materials and shapes. For example, the angle section
“LL8X8X18X0” in RISA, is named “2L8x8x1 1/8” in SDS2, and is named “2L8x8x1-1/8” in SmartPlant3D. Mapping
files are used for this purpose. If a section mapping file is provided during export, the translator will search the
mapping file for the corresponding name of the objective program, and use the new name in the CIS/2 part21
file. During import, the translator will search the mapping file for the RISA shape name and write the RISA file. 
If the mapping file is not provided by the user, the original section name will be written by the translator. 

Sample section and material mapping files with SmartPlant3D, SDS/2, and Tekla Structures are provided with
the RISA CIS/2 translator package.  Both the section mapping and the material mapping file is of XML format. 
Using the provided mapping files as template, you can write your own mapping files if communication with a
third party program is desired.

To generate a new mapping file, copy the provided section mapping file to a new file name. Open the file in
Microsoft Excel and the section mapping will be of the following format:

RISA Shape Name Shape Name
LL8X8X18X0 2L8x8x1 1/8
LL8X8X18X3 2L8x8x1 1/8x3/8
LL4X4X8X0 2L4x4x1/2
LL4X4X8X3 2L4x4x1/2x3/8
LL4X4X8X6 2L4x4x1/2x3/4
LL4X4X6X0 2L4x4x3/8
LL4X4X6X3 2L4x4x3/8x3/8
LL4X4X6X6 2L4x4x3/8x3/4

The first column is the RISA shape name. Write the corresponding shape in the second column and save the xml
file.

The format of the material mapping is:

RISA Material Name Material Name Material Type
A36 Gr.36 GRADE36 HOT_ROLLED
A572 Gr.50 GRADE50 HOT_ROLLED
Conc3000NW Concrete:Fc 3000 CONCRETE
Conc4000NW Concrete:Fc 4000 CONCRETE
Conc3000LW Light Weight Concrete:Fc 3000 CONCRETE

The first column is the RISA material name. The third column is the material type, which could be one of the six
types: GENERAL, HOT_ROLLED, COLD_FORMED, WOOD,  CONCRETE, OTHER. Write the corresponding material
name in the second column and write the correspond material in the third column. (NOTE: the material type
name is case sensitive)
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Overwrite and Update Section
During export, when an existing output file (.stp file) is picked, a dialog box will show up:

If the “Overwrite” button is clicked, the existing “.stp” file will be overwritten. If the “Cancel” button is clicked,
the translation will be canceled. 

If the “Update Member Sections” button is clicked, instead of writing a new “.stp” file, the program will read the
member section in the RISA file, search the matching member in the existing .stp file and update the section.
This feature is used when the user wants to build a model in a third party software, such as SMARTPLANT3D,
export through the CIS/2 link to RISA, design it in RISA, and update the designed section back to CIS/2 file. You
would then translate back to the third party file.

Note:

l The update member feature is not available in RISAFloor, because importing to RISAFloor is not available
in this version.

l In order for the update member feature to work correctly, the RISA-3D input file will have to have been
previously imported from the existing part 21 file. Also, the model choice (Analysis model / Design
model/ Both) option will need to remain the same during the entire import/export process.

l It is recommended that all the changes to the model are being performed using the Third Party software.
The user can delete/add/split members in RISA, but be aware that the deleted/added/splitted member
will possibly not be recognized during the update member process.
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Messages
If the translation is finished normally, the following message box will show up:

If the import model doesn’t contain the model type chose by user, the following message will show up:

Note:

l In some cases the translator will simply stop working if it can not find any analysis or design elements in
the file. Please view the Supported CIS/2 Entity List Import for the sections of the .stp file we are looking
for. If you don't have these portions in your file then no information will be translated.

If the import model contains only a part of the information the user required the following message box will
show up. For example, the user chose to export both “analysis model” and “design model”, but the input file con-
tains only “analysis model”

If the file is not a .stp file format then you may get this message:
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Supported CIS/2 Entity List (Export)

Supported CIS/2 Entity List (Export)
The supported CIS/2 entity list is as follows:

Analysis:
ANALYSIS_MODEL_3D

ANALYSIS_MODEL_LOCATED

APPLIED_LOAD_STATIC_FORCE

ASSEMBLY_DESIGN_STRUCTURAL_MEMBER_LINEAR

ASSEMBLY_MAP

AXIS2_PLACEMENT_3D

BOUNDARY_CONDITION_LOGICAL

CARTESIAN_POINT

CONTEXT_DEPENDENT_UNIT

COORD_SYSTEM_CARTESIAN_3D

DERIVED_UNIT

DERIVED_UNIT_ELEMENT

DIMENSIONAL_EXPONENTS

DIRECTION

ELEMENT_CURVE_SIMPLE

ELEMEMT_ECCENTRICITY

ELEMENT_NODE_CONNECTIVITY

ELEMENT_WITH_MATERIAL

FORCE_MEASURE_WITH_UNIT
FORCE_MEASURE

GEOMETRIC_REPRESENTATION_CONTEXT

GLOBAL_UNIT_ASSIGNED_CONTEXT

ITEM_REF_SOURCE_STANDARD

ITEM_REFERENCE_ASSIGNED

ITEM_REFERENCE_STANDARD

LENGTH_UNIT

LINE

LOAD_COMBINATION_OCCURRENCE
LOADING_COMBINATION LOAD_NODE
LOAD_ELEMENT_CONCENTRATED
LOAD_ELEMENT_DISTRIBUTED_CURVE_LINE
LOAD_MEMBER_DISTRIBUTED_CURVE_LINE
LOAD_MEMBER_CONCENTRATED
LOAD_CONNECTION
LOAD_CASE

MANAGED_DATA_ITEM

MATERIAL_ELASTICITY

MATERIAL_ISOTROPIC

MATERIAL_MASS_DENSITY

MATERIAL_PROPERTY_CONTEXT_DIMENSIONAL

MATERIAL_REPRESENTATION
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MATERIAL_STRENGTH

MATERIAL_THERMAL_EXPANSION

NODE

ORGANIZATION

PHYSICAL_ACTION_PERMANENT

PLANE_ANGLE_MEASURE

PLANE_ANGLE_MEASURE_WITH_UNIT

PLANE_ANGLE_UNIT

PRESSURE_UNIT

RELEASE_LOGICAL

REPRESENTATION

SECTION_PROFILE

SI_UNIT

VECTOR

Design: 
ASSEMBLY_DESIGN_STRUCTURAL_CONNECTION_INTERNAL

ASSEMBLY_DESIGN_STRUCTURAL_MEMBER_LINEAR_BEAM

ASSEMBLY_DESIGN_STRUCTURAL_MEMBER_LINEAR_BRACE

ASSEMBLY_DESIGN_STRUCTURAL_MEMBER_LINEAR_COLUMN

AXIS2_PLACEMENT_3D

CARTESIAN_POINT

CONTEXT_DEPENDENT_UNIT

COORD_SYSTEM_CARTESIAN_3D

DERIVED_UNIT

DERIVED_UNIT_ELEMENT

DESIGN_PART

DIMENSIONAL_EXPONENTS

DIRECTION

GEOMETRIC_REPRESENTATION_CONTEXT

GLOBAL_UNIT_ASSIGNED_CONTEXT

ITEM_REF_SOURCE_STANDARD

ITEM_REFERENCE_ASSIGNED

ITEM_REFERENCE_STANDARD

LENGTH_UNIT

LOCATED_ASSEMBLY

MANAGED_DATA_ITEM

MATERIAL_ELASTICITY

MATERIAL_ISOTROPIC

MATERIAL_MASS_DENSITY

MATERIAL_PROPERTY_CONTEXT_DIMENSIONAL

MATERIAL_REPRESENTATION

MATERIAL_STRENGTH

MATERIAL_THERMAL_EXPANSION
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Supported CIS/2 Entity List (Export)

ORGANIZATION

PART_PRISMATIC_SIMPLE

POSITIVE_LENGTH_MEASURE

POSITIVE_LENGTH_MEASURE_WITH_UNIT

PRESSURE_UNIT

REPRESENTATION

SECTION_PROFILE

SI_UNIT

STRUCTURAL_FRAME_PRODUCT_WITH_MATERIAL

STRUCTURE
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Supported CIS/2 Entity List (Import)
The supported CIS/2 entity list is as follows:

Analysis:
ANALYSIS_MODEL_3D

ANALYSIS_MODEL_LOCATED

APPLIED_LOAD_STATIC_FORCE

ASSEMBLY_DESIGN_STRUCTURAL_MEMBER_LINEAR

ASSEMBLY_MAP

AXIS2_PLACEMENT_3D 

BOUNDARY_CONDITION_LOGICAL

CARTESIAN_POINT

CONTEXT_DEPENDENT_UNIT

COORD_SYSTEM_CARTESIAN_3D

DERIVED_UNIT

DERIVED_UNIT_ELEMENT

DIMENSIONAL_EXPONENTS

DIRECTION

ELEMENT_CURVE_SIMPLE

ELEMENT_ECCENTRICITY

ELEMENT_NODE_CONNECTIVITY

ELEMENT_WITH_MATERIAL

FORCE_MEASURE_WITH_UNIT
FORCE_MEASURE

GEOMETRIC_REPRESENTATION_CONTEXT

GLOBAL_UNIT_ASSIGNED_CONTEXT

ITEM_REF_SOURCE_STANDARD

ITEM_REFERENCE_ASSIGNED

ITEM_REFERENCE_STANDARD

LENGTH_UNIT

LOAD_COMBINATION_OCCURRENCE
LOADING_COMBINATION LOAD_NODE
LOAD_ELEMENT_CONCENTRATED
LOAD_ELEMENT_DISTRIBUTED_CURVE_LINE
LOAD_MEMBER_DISTRIBUTED_CURVE_LINE
LOAD_MEMBER_CONCENTRATED
LOAD_CONNECTION
LOAD_CASE
LINE

MATERIAL_ELASTICITY

MATERIAL_ISOTROPIC

MATERIAL_MASS_DENSITY

MATERIAL_PROPERTY_CONTEXT_DIMENSIONAL

MATERIAL_REPRESENTATION

MATERIAL_STRENGTH
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Supported CIS/2 Entity List (Import)

MATERIAL_THERMAL_EXPANSION  

NODE

ORGANIZATION

PHYSICAL_ACTION_PERMANENT

PLANE_ANGLE_MEASURE

PLANE_ANGLE_MEASURE_WITH_UNIT

PLANE_ANGLE_UNIT

PRESSURE_UNIT

RELEASE_LOGICAL

REPRESENTATION

SECTION_PROFILE

SI_UNIT
VECTOR

Design:
ASSEMBLY_DESIGN_STRUCTURAL_CONNECTION_INTERNAL

ASSEMBLY_DESIGN_STRUCTURAL_MEMBER_LINEAR_BEAM

ASSEMBLY_DESIGN_STRUCTURAL_MEMBER_LINEAR_BRACE

ASSEMBLY_DESIGN_STRUCTURAL_MEMBER_LINEAR_COLUMN

AXIS2_PLACEMENT_3D

CARTESIAN_POINT

CONTEXT_DEPENDENT_UNIT

COORD_SYSTEM_CARTESIAN_3D

DERIVED_UNIT

DERIVED_UNIT_ELEMENT

DESIGN_PART

DIMENSIONAL_EXPONENTS

DIRECTION

GEOMETRIC_REPRESENTATION_CONTEXT

GLOBAL_UNIT_ASSIGNED_CONTEXT

ITEM_REF_SOURCE_STANDARD

ITEM_REFERENCE_ASSIGNED

ITEM_REFERENCE_STANDARD

LENGTH_UNIT

LOCATED_ASSEMBLY

MATERIAL_ELASTICITY

MATERIAL_ISOTROPIC

MATERIAL_MASS_DENSITY

MATERIAL_PROPERTY_CONTEXT_DIMENSIONAL

MATERIAL_REPRESENTATION

MATERIAL_STRENGTH

MATERIAL_THERMAL_EXPANSION

ORGANIZATION

PART_PRISMATIC_SIMPLE
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POSITIVE_LENGTH_MEASURE

POSITIVE_LENGTH_MEASURE_WITH_UNIT

PRESSURE_UNIT

REPRESENTATION

SECTION_PROFILE

SI_UNIT

STRUCTURAL_FRAME_PRODUCT_WITH_MATERIAL

STRUCTURE
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Tekla Structures and RISA-3D Mapping
The CIS/2 Translator can be used to transfer information either direction between RISA-3D and Tekla Structures.
This topic will give an overview on how this behavior works. The transfer of section properties, material prop-
erties and member orientation information are the primary uses of this translator.

How to Export from RISA-3D to Tekla Structures
After creating a model in RISA-3D you can transfer the analytical model to Tekla Structures for the purpose of
detailing the structure. Here is a basic outline of this process.

Setup in RISA-3D before Export
RISA-3D has detailing information that can be defined for each member in the model. For this to be visible the
Show detailing information in the model? checkbox must be checked in Tools - Preferences.

From here you can define cardinal point information. See the Cardinal Points topic for more information.

If the beam offsets are defined in the RISA-3D model as 8 Top – Center as shown, the Position setting in Tekla
Structures for beam objects will automatically be set as Behind.

Using the RISA CIS/2 Translator
See the Introduction topic for the basics of the CIS/2 Translator.

A couple of notes on using the translator:
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l Tekla Structures in general prefers to receive a CIS/2 analysis model from RISA.

l Mapping files for section shapes and material properties may be needed to be set up on either the export
from RISA-3D or the import into Tekla Structures. For information on RISA-3D mapping see the Mapping
Files topic.

l Use the Cardinal Point export option to utilize the cardinal point definitions for beam elements.

Import to Tekla Structures
Once the CIS/2 file is created (with a suffix of *.stp), the file can be imported into Tekla Structures. The steps for
importing the CIS/2 file are shown in the figure below and outlined here:

1. Choose File>Import>CIMSteel...
2. On the New Import Model dialog, make sure that Import CIS Model is selected and press the Prop-

erties... button.
3. With the Import CIS Model dialog open, go to the Input File box and search for the file. Note that the file

path length should be verified such that the entire .stp file path fits in the file path.
4. Select OK.
5. Press the Import button on the Import Models dialog and the model will then import.
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Note:

l Once the model is imported, go to the View Properties and change the View Depth to be large enough to
include the model. Also right click on the View and select Fit by Parts.
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l If there is a problem with CIS/2 that aren't importing look at the heading of the CIS/2 file. If the Logic
Product Model is anything other then LPM6 then it may not be possible to import it.

How to Export from Tekla Structures to RISA-3D
After creating a model in Tekla Structures you can transfer the analytical model to RISA-3D for the design of the
structure. RISA-3D also has the capability of transferring the model to RISAConnection, where individual con-
nections can be designed. Here is a basic outline of how this works.

Tekla Structures CIS/2 Export

1. Open the model in Tekla Structures
2. Open a view showing the parts you would like to export. Make sure to load the View settings for export-

ing via CIS/2.
3. Make sure the Select Objects in Components icon is selected.3. If no connections are to be included in this

export, only select the parts icon as well.

Note that if the
Select Components or the Select Assembly icons are selected instead, the parts themselves will not
export, even though they show up as selected in the view.

4. Select entire model.
5. Choose File>Export>CIMSteel>Analysis Model...
6. Type in name of file ending in .stp. Note that once the user sets up their standard settings, they should

save away an attribute setting in the upper right corner of the dialog box. This value can be used in the
future by loading it from the Load icon.

7. With settings defined, select Apply, select Create. The CIS/2 model will run. A DOS window may appear in
the background. That is a normal routine in the export. A note should appear in the lower left corner of
the Tekla Structures window that states "parts were successfully exported."

RISA-3D Import
Using the CIS/2 Translator of RISA-3D, the user specifies a .stp file created from Tekla Structures and imports it
as an analysis model into RISA-3D.
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Updating a Tekla Structures Model
It is also possible to receive updated models from RISA-3D and merge those changes into your current Tekla
Structures model. Here are the basic steps to this process.

1. Import the original model as described previously. Choose to save the model for future imports.
2. After making changes in RISA-3D, import the model again into the same Tekla Structures model. This

model will have its own import model name.
3. A change management dialog box will show up as shown stating what objects are added (green), modified

(yellow) or deleted (red). Note that this change management of modified members is of section size, not
moved or stretched members coming from RISA-3D.
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Tekla Structures Mapping Files
Setting up mapping files in Tekla Structures is as simple as editing a 2 column text file suffixed as a *.cnv file.
Editing these files is described further in the Tekla Help section of Tekla Structures. Some example cnv files are
located in each Tekla environment folder. Here is folder containing several cnv mapping files for the US market.

C:\ProgramData\Tekla Structures\20.0\Environments\usimp\profil

The prfexp_* files are section property mapping files while the matexp_* files are material property mapping
files.

RISA-3D Mapping Files
See the Mapping Files topic for more information.
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Technical Support
Technical support is very important to the staff at RISA Technologies. We want our users to be able to reach us
when they are having difficulties with the program.

Hours: 6AM to 5PM Pacific Standard Time, Monday through Friday

Before contacting technical support, you should typically do the following:

1. Please search the Help File or General Reference Manual. Many common questions asked about CIS/2
translator can be found in the Help File or General Reference Manual. Use the table of contents or index
to find specific topics and appropriate sections. 

2. Make sure you understand the problem, and make sure your question is related to the program or struc-
tural modeling.

3. Take a few minutes to experiment with the problem to try to understand and solve it.

Email: support@risa.com: Make sure you tell us your name, company name, serial number or Key ID, phone
number, and give a decent problem description. 

Phone Support:(949) 951-5815: Feel free to call, especially if you need a quick answer and your question is not
model specific and therefore doesn't require us to look at your file.
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